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This guide describes integrating the Factelligence NET
controls into ArchestrA including accessing their properties
and methods from script. The Factelligence .NET controls
are delivered as part of Wonderware Factelligence and can be
used in an InTouch HMI application.

You can view this document online or you can print it, in part
or whole, by using the print feature in Adobe® Acrobat
Reader®.

This guide assumes you know how to use Microsoft®
Windows®, including navigating menus, moving from
application to application, and moving objects on the screen.

If you need help with these tasks, see the Microsoft online
help.

This guide also assumes you know how to use your database

software, either Microsoft SQL Server® or Oracle®. For help
with SQL Server, see the Microsoft online help. For help with
your Oracle database, see the Oracle online help.

In some areas of the Application Server, you can also right-
click to open a menu. The items listed on this menu change,
depending on where you are in the product. All items listed
on this menu are available as items on the main menus.

Documentation Conventions

This documentation uses the following conventions:

Convention Used for

Initial Capitals Paths and file names.
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Convention Used for

Bold Menus, commands, dialog box names,

and dialog box options.

Monospace Code samples and display text.

Technical Support

Wonderware Technical Support offers a variety of support
options to answer any questions on Wonderware products
and their implementation.

Before you contact Technical Support, refer to the relevant
section(s) in this documentation for a possible solution to the
problem. If you need to contact technical support for help,
have the following information ready:

L3

The type and version of the operating system you are
using.

Details of how to recreate the problem.
The exact wording of the error ‘messages you saw.

Any relevant output listing from the Log Viewer or any
other diagnostic applications.

Details of what you did to'try to solve the problem(s) and
your results. '

If known, the Wonderware Technical Support case
number assigned to your problem, if this is an ongoing
problem.

Factelligence NET Controls Programmer’s Guide




This section shows how to configure Factelligence .NET
controls in general and how to use properties.

Overview of Factelligence .NET Controls

This sections shows a brief overview of the core Factelligence
NET controls.

Job Summary Control
The Job Summary control shows all job information related
to any jobs running on the current entity that the operator is
working on, as well as provides a link which allows the
current entity to be changed and allows the operator to login
and out of entities.

The Job Summary control has several unique properties and
methods. For a list, see Job Summary Control: Properties
and Methods on page 57.

The Job Summary control shares common properties and
methods with other controls. For a list, see Common
Properties and Methods on page 35.

Production Control
You can use the Production control to add production, reduce
production, add rejects, and view production based on
applied filters. You can use the Production control to add new
serial numbers and assign serial numbers to a job when a job
is producing serialized items.
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You can also use the Production control to transfer serialized
parts between storage locations when a job is producing
serialized items.

The Production control has several unique properties and
methods. For a list, see Production Control: Properties and
Methods on page 61.

The Production control shares common properties and
methods with other controls. For a list, see Common
Properties and Methods on page 35.

Queue Control

The Work Queue control is used to view and manipulate the
Job queue for an entity, and to change the state of a job at an
entity.

Operators use the Work Queue control to change the state of
the jobs queued to a given entity, split jobs, link jobs
together, view the routing diagram of a work order, and view
job notes and attributes.

The Work Queue control also provides a means for viewing
the job queue and starting jobs for an entity other than the
entity the operator is currently using,

The Queue control hés“’ Sevei.'a_l‘unique properties and
methods. For a list, see Queue Control: Properties and
Methods on page 67. R

The Queue control shares common properties and methods
with other controls. For a list, see Common Properties and
Methods on page 35.

Utilization Control

The Utilization control shows current and historical entity
utilization information. Data may be displayed for the
current shift, the last 24 hours, or the last week.

The operator can change the current utilization reason and
entity state, specify a final reason for a pending one, and may
modify historical data.

This control also supports the initiation of data entry jobs,
and allows the operator to end the currently running job.The
Utilization control has several unique properties and
methods. For a list, see Utilization Control: Properties and
Methods on page 91.

The Utilization control shares common properties and
methods with other controls. For a list, see Common
Properties and Methods on page 35.

Factelligence .NET Controls Programmer’s Guide




About .NET Controls & 15

Button Bar Control

The Button Bar control is a special control that provides a set
of buttons that can be used to send commands to any of the
following controls in the same ArchestrA symbol:

9%,

s Production control
» Queue control
» Utilization control

A symbol can contain a control but does not require the
Button Bar control. But, a symbol containing only a Button
Bar control does not provide any Factelligence functionality.

The following list summarizes the major steps in configuring
the symbol with the Button Bar Control:

1  FEmbed the Button Bar control on the canvas.

2 Dock the Button Bar control to the symbol.

3  Embed other controls in your symbol.

4 Associate the Button Bar control with a control.

5 Determine if the buttons of all controls associated with

the Button Bar control are shown. If the buttons of all
controls associated with the Button Bar control do not
appear, determine which control’s buttons do appear.

After you embed any other control on the canvas, you can
associate it with the Button Bar control. You associate it with
the Button Bar control by setting the ButtonBarName
property of the other control.

You can also associate multiple controls with the same
Button Bar control, The Button Bar control can either show
the buttons for:

« All controls. For more information, see
ShowAllControlButtons Property on page 49.

s A specific control. For more information, see
ShowAllControlButtons Property on page 49 and
ControlInCharge Property on page 47.

About .NET Controls

NET controls give you functionality contained in NET
controls you can use in symbols. To use this functionality,
you must:

» Import the .DLL file containing one or more NET
controls. The .NET control is imported into the Graphic
Toolbox.
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»  Browse and embed one or more of the NET controls into

a new or existing symbol. The .NET controls appear as

elements.

+  View and edit the exposed .NET control properties.

> Bind the .NET control properties to ArchestrA attributes,
symbol custom properties or InTouch tags. Do this using

the data binding animation.

+  Configure scripts for NET control events. Do this using
the events animation.

You can then use the symbol containing the embedded NET

control in an InTouch application.

— 1. Factelligence
. .NET DLL Files

IMPORT

Eraphic Toolbox

4

Factelligence

rATltomation Template or Instance

.NET Control
C EMBED EMBED , ‘
Symbol | T~ Symbol
& Factelligence Factelligence :&
.NET Control .NET Control
CEvents > CEvents ™
i ~ i

-

NET Controls
You can import NET controls into the Graphic Toolbox from

NET Dynamic Link Library (DLL) files.

After importing NET controls, you can organize them in the
Graphic Toolbox as you would with ArchestrA Symbols. For
more information, see Organizing .NET Controls on page 20.

You can also import .NET controls that have previously been

exported in an ArchestrA package ((aaPKG) file.

Factelligence .NET Controls Programmer’s Guide
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If you import a newer version of a NET control you are
already using in the ArchestrA IDE or in the InTouch HMI
as embedded ArchestrA Symbol, you need to restart the
ArchestrA IDE and/or the InTouch HMI.

Importing .NET Controls

You can import one or more NET controls from DLL files.
The NET controls can be contained in one single .DLL file or
span multiple files.

To import a .NET control, you must have security
permissions to import graphic objects.

Note If you select .NET .DLL files that do not contain NET
controls, the import process ignores these and continues at the
next .DLL file.

To import .NET controls

1 TIn the IDE on the File menu, point to Import, and then
click Client Control. The Import Client Control(s) dialog box
appears.

2 Select one or more .NET .DLL files containing the NET
controls you want to import and click Open. The Import
Preferences dialog box appears.

Import Preferences

. Objettsv from different toolkits andfuf vendor but with same tagname — """
"~ Rename object in Galaxy

™ Rename importing object

| Append to object pame; i T ' *

L

oK Cancel
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3 Select the appropriate options for the import and click
OK. The Import Client Control(s) dialog box appears.

Impott Client Control(s)

Import completed

Processing file Fack.Controls ButtonBar.all... 2
Object created with ButtorBiar Narmea,

Processing file FactMES, Controls. JobSummary,dl...
Object created with JobSummaryControf Name,
Processing file FactMES. Controls.Praduction, di., .
Object created with ProductionContraf Name,
Provessing file FactMES Contrels, Queue.dt,,,
Object created with QueusCoriteol Name,
Iriported total af & object(s) from & file(s)

File § of 5 completed

{00%processed o
,lIlllI!IIIlllllllIlll!lIl!llll!ll!lIIIIIII!]IIIIIII!II!
0000147578 ‘Close

4 When the NET controls are imported, click Close. The
imported .NET controls appear in the Graphic Toolbox.

{4#Graphic Toolbox 4 g x
coCEmm -
3 Archestra Symbel Libre
% ButtonBar
JobSummaryCordrol

i {7 QueueControl
) UtdizatianControl

Note If the import fails, a message indicates the error in the
Import Client Control(s) dialog box.

Example of Installing the Utilization and Button Bar
Control

You can install the Utilization and Button Bar controls from
the Factelligence *. DLL files. You can then use these controls
to create an ArchestrA Symbol containing the Utilization and
Button Bar control.

To install the Utilization and Button Bar control
1 Open the IDE.
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Import

=2

On the File menu, point to Import, and then click Client
Control. The Import Client Control(s) dialog box appears.

Browse to the C:\Program
Files\Wonderware\Factelligence\Controls folder and
select the following files:

o Fact.Controls.ButtonBar.dll
o TFactMES.Controls. Utilization.dll

Then click Open. The Import Preferences dialog box
appears.

Leave the default settings and click OK.
When the import is complete, click Close.

Open the Graphic Toolbox and expand the Galaxy node.
The Utilization control and Button Bar control are listed
as NET controls.

- ¢ Graphit Toolbox v I X

GRRs 4 1yGalaxy
z«;s 7y Archestrd Symbol Library
v [B) ButtonBar
- [} UtilizationControl

ing Previously Exported .NET Controls

" You can import one or more previously exported NET
controls from an ArchestrA package file (aaPKG). Previously
the .NET controls may have been:

:

Exported without a symbol or an AutomationObject
instance or template.

Embedded in a symbol and the symbol was exported.

Embedded in a symbol and contained in an
AutomationObject instance or template and the
AutomationObject was exported.

To import a previously exported ArchestrA package containing
one or more .NET controls

¢ Tmport the exported .NET control(s) the same way as you

would import an AutomationObject (.aaPKG). For more
information, see the Wonderware Application Server
User’s Guide.
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NET Controlsg

You can organize the .NET controls within the Graphic
Toolbox the same way as you would with ArchestrA
Graphics. You can:

+  Rename .NET controls.
»  Move .NET controls in and out of Graphic Toolsets.
»  Delete .NET controls.

For more information, see the Creating and Managing
ArchestrA Graphics User’s Guide.

Embedding .NET Controls

You can embed an installed .NET control into a symbol as
you would embed a symbol within another symbol.

We recommend that you not overlap .NET controls with
other elements on the canvas. Otherwise, the .NET controls
may not work correctly.

. oy To embed a .NET con»tlrol;in:to,vé_m ArchestrA Symbol
o 1 On the Edit menu, click Embed Graphic Symbol. The

Galaxy Browser appears.

G

TestGalaxy IR S
@ b 0 H
ButtonBar JobSurenstyContral ProductionControl TusueControl

UtdzationControl

[ ] o |

Whzstoncontia

Select the Graphic Toolbox.

P

Browse to the location containing the .NET control.
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Example of Embedding the Uti

4  Select a .NET control from the right panel and click OK.
= The pointer changes to paste mode.
5 Click on the canvas where you want to embed the NET
control. The .NET control is placed onto the canvas.
; Filter Log By<1361>
¢~ Current Shift<117 ¢ Last 24Hours<11 € Le
¢ Current Status<1362>
Current Reason<1190> Since<1191> Duration (hh:mm:ss)<1192>  Current OE
‘Current State<1183> Reason from /0O<1184> Target OEE %=1244>

lization and

Button Bar Controls

Follow the steps of the Example of Installing the Utilization
and Button Bar Control on page 18. Then do the following:

1
2
3

4

w

Create a new symbol in the Graphic Toolbox.
Open the symbol in the ArchestrA Symbol Editor.

Paste a rectangle on the canvas and resize it to the size
you want for your symbol. The rectangle sets the
boundaries for the Button Bar control docking. For more
information, see the Wonderware Factelligence
Integration Guide.

On the Edit menu, click Embed Graphic Symbol.
Select ButtonBar and click OK.
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6

Click on the canvas near the bottom left corner. The
Button Bar control is placed on the canvas.

On the Edit menu, click Embed Graphic Symbol.
Select UtilizationControl and click OK.

Click on the canvas near the top left corner. The
Utilization control is placed on the canvas,

Viewing and Changing the Properties of .NET

Controls

When you embed a .NET control into a symbol, the native
properties of the .NET control are imported into the
Properties Editor in property categories.

Also the element container of the NET control has properties
such as:

]

%

L

Name

X,Y, Width, Height, AbsoluteOrigin, RelativeOrigin, and
Locked

FillColor o
TextColor and Font
Enabled, TabOrder, TabStop, and Visible

The element container pﬁ‘op exties override the native
properties of the NET control.

You can view and change the properties of the control in the
Properties Editor.

To view or change the properties of a .NET control

1
2

Select the embedded .NET control on the canvas.

In the Properties Editor, locate a:

= Container property in the property categories
Graphic, Appearance, Fill Style, Text Style or Runtime
Behavior.,

¢ Native property in other property categories.

View or change the located property. For more
information, see Chapter 6 of the Creating and Managing
ArchestrA Graphics User’s Guide.
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Example of Changing the Dock Property
Tnstall and embed the Utilization and Button Bar controls
into a symbol as described in:

» Example of Installing the Utilization and Button Bar
Control on page 18.

»  Example of Embedding the Utilization and Button Bar
Controls on page 21.

In this example the Dock properties of the Button Bar and
Utilization controls are set.

The Dock properties are set to enable the Factelligence
controls to fill the symbol, resize correctly when the symbol
size is changed, and maintain the correct relative position
with each other when the symbol is resized.

For more information, see Dock Property on page 47.

To set the Dock property of the Button Bar and Utilization
controls

4 Select the embedded Button Bar control. The Properties
Editor shows all properties of the Button Bar control.

E} Appearance %
DefaultButtonBackCol [ ] Controel
pefaultuttonForeCoh [ ControlText
NumButtonlines 1 o
ScroliButtorBackColor [ 1 Control
seralButtonforeColor Il ControlText

= Design : FRE
oo

E Factelligence s

AlowConfiguration  “True

ControlinCharge

ShowaliControlsButtor: False

g e

= Layout 3 5 &
ButtonSize 64, 64
Dock None

HorizontaIBpundary; N
HorizontalSeparation -0
secrollButtonHeight 16
ScroliButtonwidth 16
SpacerHeight 32
Spacertidth a3z
VerticalBoundary 0
verticalseparation O

2 In the Layout property category, locate the property Dock.

[
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Set the Dock property to Bottom, which is above the
option None.

| Bottom

§None

The Button Bar control is docked to the bottom of the
symbol defined by the previously drawn rectangle.

Filter Log By<1361> = o oo =
wurrent ~ Lastza ~ Last
Shifre1174> Holirs<1175> Week<1176> :
o Current Status<1362> -~ — e T o
' UL Lutauui CUBIit VUEE o
Reasorn<71 1_905 » Since<1191> ) (hh:mm:ss)<1r1972> (‘136,4?, L
uitee RXEasbuiil ity ladiyet Vrc 7%
State<1193> f0<1194> <1244>
A ¢ - —_—
3
;- — — 4

4 Select the embedded Utilization control. The Properties
Editor shows all properties of the Utilization control.
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[

In the Layout property category, set the Dock property to
Fill, which is in the center.

[EEE Nooe =

Fill

iNone

The Utilization control is resized to fill the size of the
previously drawn rectangle.

Example of Changing the ControlinCharge and

ButtonBarName Properties

Install and embed the Utilization and Button Bar controls
into a symbol as described in:

» Example of Installing the Utilization and Button Bar
Control on page 18.

o Example of Embedding the Utilization and Button Bar
Controls on page 21.

In this example the CohtrollnCharge property of the Button
Bar control and the ButtonBarName property of the
.Utﬂization controls are set.

The ButtonBarName property is set to associate the Button
Bar control with the Utilization control. For more
information, see ButtonBarName Property on page 317.

The ControllnCharge property is used to set or get the 1D of
the control which currently has control of the Button Bar
control. For more information, see ControllnCharge Property
on page 47.

To set the ControlinCharge property of the ButtonBar control
1 Select the embedded Button Bar control. The Properties
Editor shows all properties of the Button Bar control.

2 In the Factelligence property category, locate the
property ControlinCharge.
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